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ETAS LABCAR-AUTOMATION 4.2.3

1 Introduction

1.1 About This Manual

The aim of this document is to help new users as well as users moving from previous
versions to easily get started with LABCAR-AUTOMATION 4.2.3. It gives an overview about
new and changed functionalities and summarizes all important information relevant for this
product release. Please read it carefully before you start installing and using LABCAR-

AUTOMATION.

The following typographical conventions are used in this document:

OCI CANTxMessage msg0 =

Choose File > -Open.
Click OK.
Press <ENTER>.

The "Open File" dialog box is
displayed.

Select the file setup.exe
A distribution is always a one-

dimensional table of sample
points.

Code snippets are presented on a gray background and in
the Courier font.

Meaning and usage of each command are explained by
means of comments. The comments are enclosed by the
usual syntax for comments.

Menu commands are shown in boldface.
Buttons are shown in boldface.
Keyboard commands are shown in angled brackets.

Names of program windows, dialog boxes, fields, etc. are
shown in quotation marks.

Text in drop-down lists on the screen, program code, as
well as path- and file names are shown in the Courier font.

General emphasis and new terms are set in italics.

All screenshots in this document relating to previous version of LABCAR-AUTOMATION are

also valid for version 4.2.3.
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1.2 Product Overview

LABCAR-AUTOMATION is a tool suite for the efficient automation of Hardware-in-the-Loop
(HiL) tests. It provides the following key features:

v Role-based development, management, and execution of automated tests on

Hardware-in-the-Loop systems.

v Open concept for integration of ETAS and 3™ party products.

v Powerful .NET®-based test case programming interface supporting various
programming languages.

4 Intuitive graphical test case creation.

v

Test case parameterization for advanced variant management.

The modular tool suite consisting of several components and add-ons providing features for
certain stages of test automation. More information on specific components and add-ons can
be found in the user guide.

Core
Components

Automation
Sequence
Builder

Test
Manager

Test Handler

Configuration
Wizard

Editors
Package

Project
Generator

Report
Viewer

Tool
Adapters

Release Notes

Runtime core components necessary for the execution of tests.

Tool for intuitive graphical test case creation.

Creating, parameterizing and managing of tests as well as creating
test sequences.

Execution of test sequences on a specific test bench.

Guided setup of test bench configurations and test projects
(Professional Edition allows configuration for all tool adapters,
Standard Edition only for installed tool adapter).

Several editors allowing to create and edit configuration files.

Allows project generation for the Embeddable Package where
Configuration Wizard and Editors are not available.

Viewing and analyzing test reports that are generated during test
execution.

Tool adapters allow the integration of several ETAS and 3 party
tools in LABCAR-AUTOMATION.
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1.3 Product Packages

LABCAR-AUTOMATION is available in different product packages, each providing a tailored
package of components and add-ons for a given use case.

LABCAR-AUTOMATION Standard Package

To immerse into the test automation for the first time or to implement test automation
in a rather small or static test bench environment the LABCAR-AUTOMATION Standard
Package is recommended.

LABCAR-AUTOMATION Professional Package

Additional tool connections and features, in-depth managing of configurations and units
under test are the benefits of the effortless extendible LABCAR-AUTOMATION
Professional Package.

LABCAR-AUTOMATION Embeddable Package

Integration of the LABCAR-AUTOMATION into an existing tool chain provides test case
and test project management as well as automated test project creation. They can be
configured and triggered from within customer’s tool chain.

LABCAR-AUTOMATION Easy Offline Package

For graphical or programming-based test case development without the need of online
test execution on the test environment the LABCAR-AUTOMATION Easy Offline Package
is recommended.

The package can be selected by the user during the product installation and requires a
respective license as described in chapter 1.3.

The table below shows the content of each package. The components and add-ons with a
check mark are part of the respective product package. All others can be ordered and
installed separately to the package.

Release Notes 7
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Core Components
Core Engine
Automotive Test Class v v v v
Library
Manuals and Examples
SuT Mapping File Editor

Report Viewer

Automation 7 7 v X
Sequence Builder

Confi i Y . "
O-n |guratlon (Standard (Prof. (Standard X
Wizard Edition) Edition) Edition)

Test Manager v v X X

Test Handler v 4 X X

Editors Package
Switch Definition File
Editor
Test Bench Configuration X v X X
File Editor
Tool Configuration File
Editor
UuT List Editor

Project Generator X X X

Tool Adapter
Standard
Offline Test Bench v v v v

Connector
ETAS LABCAR-
OPERATOR
ETAS INCA

Tool Adapter

Extened
ETAS INTECRIO
ETAS Real Time Testing X v X X
ETAS ODX-Link
ETAS Fault Simulation
(ES4440)

Tool Adapter Misc
OCT 11699 X X X X
Microsoft Excel

v’ Part of product package
x Needs to be purchased separately
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1.4

Electronic Licensing

LABCAR-AUTOMATION is protected by electronic licensing. Each component and add-on
requires a respective license. The use of unlicensed ETAS software is prohibited. The
required licenses are not included with the delivery of the product. For more information
about license purchasing contact ETAS.

After purchasing LABCAR- AUTOMATION licenses, you receive a separate entitlement letter
with instructions, how to activate your licenses using a self-service portal on the ETAS
website (http://www.etas.com/support/licensing). During these steps you receive the
necessary license files.

Depending on the license type you need to provide your user name or a MAC address. To
retrieve both, please execute “License Info” included on the LABCAR-AUTOMATION
installation medium (Data\Licensing) or from the “"ETAS/License Management/ETAS License
Manager” entry in the Windows start menu via Tools->Obtain License Info->Get License
Info. The information can be saved as file and sent to ETAS.

If you have a valid service contract for LABCAR-AUTOMATION, your license files from
previous versions can be further used with this version.

The use of unlicensed ETAS software is prohibited also in case of service pack installations.
If you have a valid license for the base release, these are valid for the Service Pack as well.
There is no need to require a new or separated license for a service pack. The required
license for the base release is not included in this delivery.

Release Notes
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2

2.1

2.2

2.3

Product Compatibility

System Requirements

The installation and operation of LABCAR-AUTOMATION 4.2.3 has the following system
requirements:
2 GHz Dual Core PC or higher

4 GB RAM
(8 GB RAM recommended)

Hardware:
1 GB free hard disk space!
(Minimum)
DVD-ROM
Ethernet Adapter 10/100BaseT
(2 x Ethernet Adapter 10/100BaseT recommended)
Operating Microsoft Windows 7
System: Microsoft Windows 10

All software documentation is available in the Portable Document Format (PDF), which
requires Adobe Reader. You can download the latest version from the Adobe website
(http://get.adobe.com/de/reader).

To view the PDF Report which can be generated with PDF Report generator during test
execution as well requires the Adobe Reader.

Version Compatibility

The interoperability of the components and add-ons within a certain version of LABCAR-
AUTOMATION is ensured by a common release test. Other setups, e.g. in combination with
components and add-ons from previous versions, are not supported.

LABCAR-AUTOMATION 4.2.3 is compatible with SuT Mapping File Editor version 4.1.0 which
is included in the LABCAR-AUTOMATION installation.

For latest updates and information visit also the ETAS Download Center
(http://www.etas.com).

Product Compatibility

The open and flexible concept of LABCAR-AUTOMATION allows the integration of different
tools. Following an overview about the tools and respective versions that are currently
supported is given.

! Hint: Application data not considered, esp. maximum size of generated test reports depend on free hard disk space

Release Notes 10
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2.3.1 Supported ETAS Products

LABCAR-AUTOMATION 4.2.3 is compatible to the following ETAS products:

Compatible
Version

Supported Product

LABCAR-OPERATOR 5.0.0-5.4.2
Model Access INTECRIO 3.1.1
(via Common Experiment 3.2
Environment 3.2 or higher) 4.x
6.2.1
INCA 7.1.10
7.2.2
ECU Access LABCAR-OPERATOR
(with INCA, see LABCAR-
OPERATOR User Manual for 5.0.0-54.2
supported INCA versions)
LABCAR-OPERATOR
(with INCA, see LABCAR-
Sync DL OPERATOR User Manual for 5.0.0-5.4.2
supported INCA versions)
INCA 6.2.1
i i (with ODX-Link, see INCA =
DIEETIORINE (e User Manual for supported 7.1.10
ODX-Link versions) 7.2.2
OBD/EOBD
J1699 Conformance Test 4.2.12

Fault Simulation

Release Notes

System ("OCT")
LABCAR-PINCONTROL

LABCAR-OPERATOR
(see LABCAR-OPERATOR User
Manual for support of failure
simulation)

2.0.0/2.1.0/2.23

5.0.0 - 5.4.2
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2.3.2

2.3.3

Supported 3™ Party Products

LABCAR-AUTOMATION 4.2.3 is compatible to the following 3" party tools:

Supported Compatible Related

Product Version Product Component
Microsoft o

Visual Studio 5013 Test Design Connector

(incl. Express Microsoft .NET (TDCNET)
Editions)

2010
AIETEESE (572 ;giz Test Bench Connector Excel (TBCEX)

In addition LABCAR-AUTOMATION 4.2.3 also provides tool adapters for different 3 party
tools (e.g. dSPACE ControlDesk, Vector CANape and others). However, these tool adapters
typically require customer specific integration and test efforts to ensure full compatibility.
Therefore tool adapters are provided by ETAS Engineering Services on customer request.

For detailed information about available tool adapters or development of specific tool
adapters, please contact ETAS.

Support of ASAM XIL

ASAM XIL is a standard defined by ASAM with the aim to enable reuse of test cases and to
decouple test automation software from test hardware. Please refer to the ASAM website for
detailed information (http://www.asam.net).

The standard contains two parts:

ASAM XIL Framework: Defines interfaces to describe a test case, similar to the LABCAR-
AUTOMATION Automotive Test Class Library (ATCL) concept.

ASAM XIL Test Bench: Defines interfaces to connect test automation software and test
hardware, similar to the LABCAR-AUTOMATION port and tool adapter concept.

The ASAM XIL Add-On provided with ETAS LABCAR-AUTOMATION 4.2.3 provides additional
interfaces of the ASAM XIL standard within LABCAR-AUTOMATION.

This Add-On is not exhaustive and has not yet participated in an official ASAM XIL cross test
to ensure compatibility with other tool vendors. Therefore, it is provided for customer
evaluation purposes only.

Any customer feedback helps to improve the Add-On and can be submitted to the ETAS
Hotline (http://www.etas.com/en/hotlines.php).

The Add-On is based on version 2.0.1 of the ASAM XIL standard. For details about the
available interfaces and detailed description refer to the documentation which is part of the
Add-On installation.

Release Notes 12
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3 Product Installation

To install LABCAR-AUTOMATION please follow the guidelines described in chapter 2
“Installation” of the user’s manual provided in the “Data/Documentation” directory of the
installation CD.

In general the following issues should be considered for installation.

1344848

4

43

Do not mix products and/or add-ons of different versions of LABCAR-AUTOMATION
Shutdown all running applications (especially all ETAS applications have to be closed).
Uninstall previous versions of LABCAR-AUTOMATION

Please follow Chapter 3.1 of this document if you like to take over your Test Handler
options (new feature since LABCAR-AUTOMATION 3.4).

For a convenient LABCAR-AUTOMATION installation please use the guiding htm/
pages, opened when inserting the CD into the PC drive. If the Auto Play option of
your disk drive is switched off, please start the autostart.exe from the root of the CD
directly.

Before installation of LABCAR-AUTOMATION the installation of Microsoft .NET
Framework V4.6 is required. One may find the online installation of Microsoft .NET
Framework V4.6.1 Redistributable at the Installation CD.

After installation of Microsoft .NET Framework a reboot of the PC is required.

For Visual Studio 2013 the .NET 4.6.1 Targeting Pack has to be installed. (Available on
the installation CD)

The Report Viewer internally uses the Internet Explorer installed at your system to
visualize the reports. To visualize plots present as SVG files an appropriate SVG viewer
/s necessary. At Windows 7 systems assure that Internet Explorer 9 is installed (it
includes a SVG viewer by default).

Special installation guidelines regarding other ETAS products and 3rd party products can be
found in the chapter “Hints” at the end of this document (Chapter 0)

3.1 Test Handler Options

The options of the Test Handler are managed in a configuration file. During installation these
options are preset as follows:

Release Notes

In case of a fresh installation these options are set to default values.

If it is intended to use the Test Handler options from a former version (different
installation folder) you can export it with the old version before uninstall the old
version and then import the options into the new version after the installation.

If you use the import function the Test Handler has to be restarted to reflect the
changes resulting by the imported options file.

Starting with LABCAR-AUTOMATION 4.2.3: If you had formerly installed the same
version (same installation folder by default), or another version in the same target
folder, the Test Handler options were not deleted during uninstall or during repair
installation. The saved options are taken over for the new or repaired installation.

If you like to force an initial set of Test Handler options, please delete the
corresponding ToolOptions.conf file (e.g. for Windows 7 file

"% ProgramData% |ETAS|LABCAR-AUTOMATION 4.2|confToolOptions.conf™)
manually.

13
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3.2 SuT Mapping File Editor (SMFE)

The SuT Mapping File Editor (SMFE) comes together with LABCAR-AUTOMATION 4.2.3. It
will be automatically installed when one of the LABCAR-AUTOMATION packages will be
installed on your computer.

= During uninstallation of LABCAR-AUTOMATION older LABCAR-SMFEditor versions are

not uninstalled.
= It has to be manually uninstalled in the Windows control panel via Settings — ->
Control Panel -> Add or remove programs.

LABCAR-OPERATOR (LCO) brings the same version with its installation. If installed with

LABCAR-AUTOMATION (LCA) as well as LABCAR-OPERATOR the SMFE will not be uninstalled

before both (LCA and LCO) are uninstalled.

3.3 Installation of Further Components

In case you extend your system with further components there are two ways depending on

the component you like to install.

jlj! LABCAR-AUTOMATION 4.1.0 Setup

Change, repair, or remove installation

All components and Tool Adaptors which are
part of one of the LABCAR-AUTOMATION
packages (ref. to chapter 0) are available via
the setup. You just have to insert the LABCAR-
AUTOMATION product CD and start installation

Select the operation you wish to perform,

B =

.l ; ¥ Lets you change the way features are installed,

again. A [ e
Lij. Repairs errors in the most recent installation by fixing missing and corrupt
files, shortcuts, and registry entries,
= If the installation does not start after =

@j Removes LABCAR-AUTOMATION 4. 1.0 from your computer,

insertion of the CD, the option to
autostart’ the media is disabled in your

explorer. In this case double click the Py
autostart.exe file at the root directory of
your CD.

As soon as the LABCAR-AUTOMATION setup was started successfully you have the choice to

change, repair or remove the package. Please select Change.

The next window provides you the possibility to select the components to install additionally.

All former installed ?arts are already selected. If it's already installed it is marked as =]

otherwise a cross X _~lis shown. To select a component click on this icon. In the picture
below for example the FS port Tool Adaptor will be newly installed:

= =] LABCAR Automation
= Q-l Core Components
- | Manuals
= | Basic components
~ | 5uT Mapping component
hell Components
~ | Test Creation
~ | TestManaging
= | TestHandling

U

E|®

== |

e

~ | Editors

- | Misc

Q-l Configuration Wizard
== | Tool Adapters

RealTime Scripting ToolAdapter
dSpace ToolAdapter

Diagnose ODX Link ToolAdapter

Fault Simulation ToolAdapter (ES54440)

=) Wil be installed on local hard drive
=38 Entire feature wil % installed on local hard drive

[opefole

B

PP

X Entire feature wil be unavailable

Release Notes
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The component Configuration wizard contains both, the standard and the professional version. If you
have already installed the LABCAR-AUTOMATION Standard package and like to upgrade the
Configuration Wizard to the professional level you do not need to install or re-install the component.
The control about the level is realized completely by the license you've got. It is also not necessary to
remove the Configuration Wizard Standard License (LCS _LCA_CWS) from your computer, your initial
license file or at the license manager. The component recognizes automatically the higher level,

3.3.1

3.3.2

Click Next and confirm the change at the next page. The completion will be reported in the
final window.

Registry Changes

The root path in the registry for the LCA has changed and now does not contain any more
the version: "HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\LABCAR-AUTOMATION". Below that
path there is a registry folder with the current version.

Since the product version was changed so that it only has two digits the registry key look
like the following: “"HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\LABCAR-AUTOMATION\4.2"

Additional Components

There are some additional components available which are not installed with one of the
predefined packages:

e Tool Adapter for Microsoft Office Excel Tables
e Tool Adapter for Onboard control tester / 11699 Standard

All of these components you can install via the separate tools and utilities entry in the
Installation CD Menu.

Select at the next window the ETAS Add-Ons at the right menu pane or select the first link
,Get a list of the related LCA utilities and our Tool adaptors here.’

Select the Add on you like to install by clicking the appropriate link.

Depending on your security level you might get one or two security information if you allow
the download of the file (from your installation CD). Please confirm this dialogue with ,Run’
and the installation will starts.

Release Notes 15
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3.4 Service Pack Installation

To install LABCAR-AUTOMATION please follow the guidelines described in chapter 2

“Installation” of the user’s manual provided in the “Data/Documentation” directory of the
installation CD.

T Please follow chapter 3 Product Installation to see all relevant
information of the installation

A LABCAR-AUTOMATION Service Pack comes as a complete delivery of the
LABCAR-AUTOMATION software package.

= It is required therefore to uninstall the previous used version, if you have
Installed

a former build or
a former service pack.

For the installation of the Service Pack please do the following:

Install the LCA package from this CD as usually and select the package which is the valid
one for you. (Standard, Professional, ...). Follow the instructions for a normal installation.
Important hints you find as well at chapter 0 .

3.4.1 Problems with sporadic crashes of Test Handler

The memory configuration for Test Handler is by default 600 MB. For large projects this
default value might lead to undesired problems and needs to be increased.

The memory configuration can be changed in the file

“\TestTools\Bin\TestHandler.exe.config” of the LABCAR-AUTOMATION installation folder by
defining the number of allocated memory in Bytes as value for the key “MemorySize” (e.g.

1048576000 Byte):

<appSettings>

<!-- Timeout for the SARProcessController to startup the SARHost.exe --3

<!-- add key="SARHostStartupTime"” value="l@@@8" / -->

<!-- Maximum Memory Size of the Engine before restart. In Byte - 18MB = 184857608; 68GMB = 529145660 -->
<add key="MemorySize" value="1@48576@0@"/> == 1GB

</appsettings>

Important Notes.

In the case you had installed up to now additional tool adaptors, these have to be

Installed as well newly, to provide them for the execution chain. Access the installation

again and select through the bullet 'Custom’ the appropriate adapter and start the
installation. See chapter 3.3 Installation of Further Components for detailed
information.

I Licenses are not to be changed for a service pack.

Release Notes
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4.1

4.1.1

Changes in LABCAR-AUTOMATION 4.2.3

This chapter describes major changes of LABCAR-AUTOMATION 4.2.3 with respect to the
previous version.

New Functionality in LABCAR-AUTOMATION

New Functionality in LABCAR-AUTOMATION 4.2.3

4 Main features at a glance:

v Support of Microsoft .NET 4.6.1

v~ Support of Windows 10

v Tool Adapter for ETAS LABCAR-OPERATOR 5.4

v~ Tool Adapter for INCA 7.2.2 standalone

v~ TCF file migration

Support of Microsoft Windows 10
LABCAR-AUTOMATION supports Windows 10 (with installed Internet Explorer 11).

Support of Microsoft .NET 4.6.1

LABCAR-AUTOMATION is now based on Microsoft .NET framework 4.6.1. If test cases are
compiled with LABCAR-AUTOMATION 4.2.3, .NET framework 4.6.1 is required. However,
test cases already compiled with previous versions can still be executed with LABCAR-
AUTOMATION 4.2.3.

Tool Adapter for ETAS LABCAR-OPERATOR 5.4 and INCA 7.2.2 standalone

LABCAR-AUTOMATION 4.2.3 includes the support for LABCAR-OPERATOR 5.4.2 and as well
INCA 7.2 standalone.

TCF file migration

The TCF-Editor now has a migration feature to migrate tool configuration files of an older
tool version to a newer tool version.
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4.1.2 New Functionality in LABCAR-AUTOMATION 4.2.2

LABCAR-AUTOMATION 4.2.2 includes several improvements regarding performance and
memory consumption for Automation Sequence Builder and SMF-Editor as well as further
quality improvements.

4.1.3 New Functionality in LABCAR-AUTOMATION 4.2.1

2l Main features at a glance:

v~ Comment out of stencils in Automation Sequence Builder

~ Support of Microsoft Windows 8.1

Comment out of stencils in Automation Sequence Builder

Automation Sequence Builder now supports to comment out parts of a sequence from
generation. The respective stencils can be commented out by right click on the selected
stencil and are greyed out afterwards.

VariableName RVETFIA

8

FJ
$ 4

IScaIar v ||Integer ¥ |[|time ¥
9 J J

30 s 7

Set Model Value

Scalar ¥ Ml Boolean ¥

Value
&

A detailed description of this new feature can be found in the Automation Sequence user
guide.

Support of Microsoft Windows 8.1

After the Windows 8 support introduced with LABCAR-AUTOMATION 4.2.0 now also
Windows 8.1 is supported.

Configurable Signal Generator Input Mode Mapping

LABCAR-AUTOMATION allows deciding between two different mapping behaviors for the
Signal Generator Input Mode.

The mode can be defined by the newly introduced flag “Inport Mode” within the test bench
configuration (tcf).
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e Inport Mode = False (Default Mode): Mapping behavior represents for
compatibility reasons the behavior of previous version of LABCAR-AUTOMATION as
introduced with older versions LABCAR-OPERATOR Experiment Environment. This is
the default behavior of LABCAR-AUTOMATION.

e CONST=0
e STIMULI=1
e MODEL=2

e STIMULI + MODEL=3
e STIMULI* MODEL =4

e Inport Mode = True (Latest Mode): Mapping behavior represents the latest
behavior of the supported LABCAR-OPERATOR Experiment.

CONST =0

MODEL =1

MODEL_PLUS_CONST =2
MODEL_MULT_CONST =3
MODEL_PLUS_SIGNALGENERATOR =4
MODEL_MULT_SIGNALGENERATOR =5
SIGNALGENERATOR =6
SIGNALGENERATOR_PLUS_CONST =7
SIGNALGENERATOR_MULT_CONST =8

Hint: This feature is only supported with the tool adapter for LABCAR-OPERATOR
Experiment Environment 3.5 or higher!
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4.1.4

New Functionality in LABCAR-AUTOMATION 4.2.0

4 Main features at a glance:

v~ Support of Microsoft Windows 8 and Microsoft .NET 4.5

v~ ASQ Batch Generator for Automation Sequence Builder

v~ Tool Adapter for ETAS INCA 7 and ETAS LABCAR-OPERATOR 5.3

~ Report Viewer Standalone Installation

v~ ASAM XIL Evaluation AddOn for LABCAR-AUTOMATION

v~ Configurable Signal Generator Input Mode Mapping

Support of Microsoft Windows 8

LABCAR-AUTOMATION now officially supports Windows 8. Other versions, e.g. Windows 8.1,
are not fully covered by release tests and might be used without warranty for compatibility.

Support of Microsoft .NET 4.5

LABCAR-AUTOMATION is now based on Microsoft .NET framework 4.5 (compared to
Microsoft .NET 4.0 in LABCAR-AUTOMATION 4.1).

If test cases are compiled with LABCAR-AUTOMATION 4.2.0, .NET framework 4.5 is
required. However, test cases already compiled with previous versions can still be executed
with LABCAR-AUTOMATION 4.2.0.

ASQ Batch Generator for Automation Sequence Builder

Automation Sequence Builder now provides the ASQ Batch Generator to automatically
generate all .asq files within a selected folder. The feature can be found in Automation
Sequence Builder under Tools -> Plugins -> ASQ Batch Generator.

Release Notes 20



ETAS LABCAR-AUTOMATION 4.2.3

{2) ASQ Batch Generator =NRE X
Source Folder  C\Users\Bublic\Documents\ETAS\LABCAR-AUTOMATICN 4.2 | Subdirectory
Generator ATCLTestCaseASBGenerator ... h |
Output Folder  CAUsers\lehZabt\Desktop |

» | Details

Status  Sequence Name Description

40 %0 @0 Ready

The dialog allows to select an input folder (where your .asq files to be generated are
located). With the checkbox behind that selection you can decide if also the child directories
shall be recursively scanned for ASQs to be generated. The results of the generation will be
stored in the selected output folder (existing files will be overwritten). The generation will
use the selected generator (e.g. to decide between generation of test case executables or
libraries). Information about successful or unsuccessful generation for each .asq file will be
shown in the lower part of the dialog.

Tool Adapter for ETAS INCA 7.1 and ETAS LABCAR-OPERATOR 5.3

With LABCAR-AUTOMATION 4.2.3 a new INCA standalone tool adapter is available. This tool
adapter allows to connect LABCAR-AUTOMATION directly with INCA for accessing ECU
calibration, measurement and diagnostic data. A separate LABCAR-OPERATOR license is not
required.

As in previous version, also a tool adapter for accessing INCA via LABCAR-OPERATOR is
provided. This tool adapter allows in comparison to the standalone tool adapter also a
synchronized logging of INCA and LABCAR-OPERATOR data. However, this requires an
additional LABCAR-OPERATOR license.

Both tool adapter support now the latest INCA version 7.0 and 7.1. Equal to previous

versions of LABCAR-AUTOMATION, the Configuration Wizard and the Test Bench
Configuration File Editor allow to select and configure the respective tool adapter.

For the different possibilities to use INCA with LABCAR-AUTOMATION, please see ‘How to..."-
document chapter 2.4.1.
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4.2

Report Viewer Standalone-Installation

The installation of LABCAR-AUTOMATION 4.2.3 now offers to install only the Report Viewer
without other product components. The Report Viewer can be used without license. This
enables to distribute test reports generated with LABCAR-AUTOMATION within the
organization and conveniently view them, e.g. for review or analysis purposes.

ASAM XIL Evaluation AddOn

The ASAM XIL Evaluation AddOn provides many of the interfaces as specified in the ASAM
XIL standard, e.g. to integrate with 3™ party tools. For more information refer to chapter
2.3.3 of this document.

Miscellaneous

Besides the described key features there are several smaller or hidden improvements of
LABCAR-AUTOMATION. Chapter 4.3 gives an overview of customer issues solved with this
version of LABCAR-AUTOMATION.

Automation Sequence Builder now comes with improved memory consumption and
provides now a better performance and reactiveness than ever before. The Favorite panel in
Automation Sequence Builder now also allows to store so called Value-Stencils (those with
an round icon on their top).

For the property panel of the SuT Mapping File Editor, a check of the property values is
introduced.

Migration from LABCAR-AUTOMATION 3.1 to LABCAR-AUTOMATION 4.2.3

Data structures from LABCAR-AUTOMATION 3.1 projects must be converted to the current
data structures.

Please be careful that projects that shall be opened with LABCAR-AUTOMATION 3.1 may not
be opened and saved with LABCAR-AUTOMATION 4.2.3.x.

= After opening a project with LABCAR-AUTOMATION 4.2.3.x the project cannot
be opened with previous versions (3.1 and earlier)

A detailed description of migration steps and hints regarding the change of version is
available in the document “"LABCAR-AUTOMATION - From 3.1 to 3.2.pdf” which can be
found in the LABCAR-AUTOMATION start menu group and on the installation CD.

Release Notes 22



ETAS LABCAR-AUTOMATION 4.2.3

4.3 Solved Customer Issues

4.3.1 Solved Customer Issues in LABCAR-AUTOMATION 4.2.3

The following customer issues are solved in comparison to LABCAR-AUTOMATION 4.2.2 (ID
and Title referring to the ETAS Issue Tracking System):

_

LCA4.2.1: Heterogeneous representation of legend in LCA
501100 plot

4.3.2 Solved Customer Issues in LABCAR-AUTOMATION 4.2.2

The following customer issues are solved in comparison to LABCAR-AUTOMATION 4.2.1 (ID
and Title referring to the ETAS Issue Tracking System):

_

471139 LCA 4.2.0: Issue Viewing the Details of LCA Test Report
LCA 4.2.0: ASB Test case with ForEach Excel Stencil will
474648 run in ASB but not Test Manager
LCA 4.2.1: ReportLevel Filtering for Plots in LCA Report
501096 Viewer
501098 LCA 4.2.1: Y-axis shifted in plot

476641 LCA 4.2.0: ASQ Batch generator fails for some testcases

4.3.3 Solved Customer Issues in LABCAR-AUTOMATION 4.2.1

The following customer issues are solved in comparison to LABCAR-AUTOMATION 4.2.0 (ID
and Title referring to the ETAS Issue Tracking System):

_

LCA 4.1.0 SP1: Problems with usage of data logger within
448025 generated DLL

LCA 4.1.0 SP1: Unit in stencil substring saved wrongly
455710 (e.g. [A] instead of [mA])

LCA 4.1.0 SP1: ASB stencil fault simulation update fails
466129 (change of pin name)
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4.3.4 Solved Customer Issues in LABCAR-AUTOMATION 4.2.0

The following customer issues are solved in comparison to LABCAR-AUTOMATION 4.1 (ID
and Title referring to the ETAS Issue Tracking System):

_

LCA 4.2: LCO 5.3.0 EE 3.5.0 Signalgenerator signalflow

453096 ) -
mappings not matching
LCA 4.2: TestRuns folder will be locked after generating
449349 '
the batch project.
449377 LCA 4.2: ReportViewer does not display SVG Plots
373311 Test Manager: Positioning toolbars
413719 Test Handler: Plot Display Settings Plot Height and Width
385397 ASB: New sequence is hidden behind Welcome... tab
407984 ASB: Verify DTC - 'Bus doesn't exist' error with no TLA
437669 ASB: _CaICL!Iatlion using Units: ERROR: Cannot convert from
no unit to '%
ASB: Stencil Configure Signal Generator must be named
420132 . ;
like Signal Generator Name
420139 ASB: Help, documentation and example improvements
(Configure SG, Fault Simulation)
410150 ASB: Crashes by opening if Global Switch Definition File

format is incorrect
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4.4

4.4.1

4.4.2

4.4.3

Known Issues

This section describes known problems of the released version 4.2.3.

Measurement of INCA Indexed Values

Starting from INCA 6.2.1 HF17 for indexed values in INCA a new feature is available. It can
be decided by the customer, where the index will be oriented in the naming:

Option Index Alignment = ‘Left’: aaaal[l] .bbbb.cccc.dddd
Option Index Alignment = ‘Right’: aaaa.bbbb.cccc.dddd[1]

The default selection with this feature is ,Left’, while the orientation in the past was ,Right’,
therefore LABCAR-AUTOMATION translates all indexed values like ,right-oriented'.

( User options - User: - ﬂ‘
To ensure correct operation with the
datalogging of indexed values it is Data e:(change l ASAM-2MC Edl.tor l General l Autostart l
necessary to set the user option in Hecfiles | Adtocommit | Import/Eport |
(;w”;; oDx l Limnited EMU RAM ] Calibration Session Log ] Path l

INCA correctly .

' Database l & Hardware l
Select from Menu Bar -> Options ->
User Options and activate the tab E’Ipetal:;re 1:r?ltl;:neral Measure window, Osc
,Experiment’. Look at this tab for the - R S
entry IndeX Alignment, and set it to Calibration «<-General, Calibration, Table edi
Right'. Marme Alignment Left
! g :IndexAIianment | |Le‘Ft

Adjust font in the variable views |Left
if the view size is changed

. i i . View of search dialog By Structure
This option set_tlng is o.nly necessary Autormatic start of date No
once after the installation of the INCA visualization
Hotﬁx_ Display variables of all Yes

subfunctions

4 il 2

The index (e.q. for array-sub-element names) will be added te «
the right hierarchy location in the format
aaaa.bbbb.cccc.dddd_[1]

-

QK Cancel Default

No Calibration of TAB_VERB Array Parameters Possible

It is not possible to set array parameters defined in INCA (.a2l) as TAB_VERB. However
reads are possible.

Maximal Path Length and Special Characters

Windows restricts paths to a maximal length of 248 characters. This should be kept in mind
when setting up LCA projects. E.g. when creating project structures with the Configuration
Wizard or the Automation Sequence Builder the root directory should not be placed too deep
downwards the directory tree. The resulting path lengths result from that root directory as
well as the length of the project/test name given.

Further the usage of special characters should be prevented. Means no special characters
should be used within path (directory and file names) used with LCA.
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4.4.4

4.4.5

4.4.6

4.4.7

4.4.8

4.4.9

4.4.10

Maximal Nesting Depth in Automation Sequence Builder (ASB)

Due to a restriction of WPF (the .NET base technology that is used a base of ASB) there is a
restriction in the maximal nesting depth of stencils in ASB. With the currently used
framework version (.NET 4.5) this threshold is at 35 stencils nested into each other.

Changed Behavior of Copy & Paste of Hierarchies in SuTMapping Editor

With the introduction of the new SuT Mapping Editor 4.x when copying hierarchies the
related test label are no more copied. This was done as hierarchies are purely seen as
structural elements. It was not seen as sensible to duplicate all related lables.

ASB Stencil Fault Simulation

In case of selection of multiple errors in the ASB stencil Fault Simulation only the LoadFlag
of the last error entry is been used. That means in case the load flag is set for the last error
in the multiple error set, all errors of the multiple error set are connected with load.

Debug Break in Test Handler

With LABCAR-AUTOMATION 4 the behavior of DebuggerBreak functionality available in the
Test handler application has changed (available at the 7est Case Executor page of the
options dialog Tools > Options...).

When having the DebuggerBreak flag set to True, at the beginning of each test execution
the “VS Just-In-Time Debugger” window appears that allows you to select a Visual Studio
instance to be used for debugging. If aborting this dialog (by pressing the Ao button) the
test execution will abort at all. Means the resp. test will no more be executed, but the next
test case of the sequence will be started.

PDF Report Sink

With LABCAR-AUTOMATION 4 a new Report Sink is available. When using this report sink
the memory consumption of the LABCAR-AUTOMATION Core is higher than before and
sufficient memory needs to be ensured, esp. for endurance tests.

Support of ODX-Link with INCA

When changing to a new version of INCA with ODX-Link, the compatibility to an existing
INCA database created with a previous version could get lost. This is due to the changed
configuration of ODX in INCA. There is no possibility to migrate the INCA database to
directly support the new version of ODX. This has to be set up from scratch.

The INCA 7.1 and ODX Link tool configurations have both gotten a new property “Initialize
Hardware” to switch off or on the call of initialize hardware in the configure call of the tool
adapters. For the usage of ODX Link this has to be switched off (set to “false”).

Debugging in the Automation Sequence Builder with Nested Sequences

In case of debugging of nested sequences there are some changes/improvements. When a
nested sequence contains a breakpoint and the debugger stops, the nested sequence now is
opened. Formerly the sequence was not opened but nevertheless the debugger stopped and
the user did not see it.

The debug messages now are no more written to the currently active sequence, but to the
sequence to which they belong. Additionally when a nested sequence is debugged, all
messages written to the debug output from the time beginning when the nested sequence is
started to be debugged, are written to the output of the main and the nested sequence.
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4.4.11 Generate or Debug an Unsaved Sequence

It is no more possible, to generate or debug a sequence that never has been saved. The
reason for this behavior is, that it is not obvious to the user, where the generated files are
saved. If a user starts the generation or debugger a save as dialog is shown. After saving
the generation or debugging is continued. In case of the abortion of the saving, generation
or debugging is cancelled and the following message is written to the message log:
"Sequence has to be saved before test case generation can be started! Generation and
debugging is cancelled."

This behavior applies only if a new sequence was created and was not yet saved. This
means a sequence is not saved if it just contains unsaved changes.

4.4.12  GetLoggedSignals Exception: Channel Times Could not be found in file

With the method “GetLoggedSignals” a file is loaded into the memory. If the file size is large
(app. with more than 250 MB), this can exceed the available memory and an exception is
thrown. This memory limit is given my Microsoft Windows for 32 Bit applications. As
workaround the selection of a recording task that reduces the number of logged signals or
to use a single signal read methods instead.

4.4.13 Problems with debug execution if sequence contains blank and minus

If an .asq file name for Automation Sequence Builder contains a space follow by a minus
(e.g. “File -.asq") an execution of the sequence in debug mode is not possible. As temporary
workaround, a different file name should be chosen.

4.4.14 Problems with sporadic crashes of Test Handler

The memory configuration for Test Handler is by default 600 MB. For large projects this
default value might lead to undesired problems and needs to be increased.

The memory configuration can be changed in the file

" \TestTools\Bin\TestHandler.exe.config” of the LABCAR-AUTOMATION installation folder by
defining the number of allocated memory in Bytes as value for the key “MemorySize” (e.g.
1048576000 Byte):

<appSettings>

<!-- Timeout for the SARProcessController to startup the SARHost.exe --3

<!-- add key="SARHostStartupTime"” value="l@@@8" / -->

<!-- Maximum Memory Size of the Engine before restart. In Byte - 18MB = 184857608; 68&MB = 629145660 -->
<add key="MemorySize" value="1@48576@0@"/> == 1GB

</appsettings>
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5 Im

portant Notes

This chapter lists information and latest issues which are important to know by the user.

5.1 Installation Hints for LABCAR Test Benches Operating With LABCAR-AUTOMATION

The following information is addressed to users working with different ETAS and non-ETAS

tool

s on a test bench.

When installing LABCAR-AUTOMATION it is recommended to keep the following sequence
for the ETAS Software products:

1, INCA

2. ODX Link

3. LABCAR-OPERATOR

4, LABCAR-AUTOMATION
5.2 Issues due to 3™ Party Products

While installing LABCAR-AUTOMATION or one of its add-ons: In case you detect an error
like "Error 1335: The cabinet file ... is corrupt and cannot be used" and if you ignore the
error message, it repeats with a different cabinet file name, this is a Microsoft Installer
issue. Please re-install the Microsoft Installer software. You find it at the installation CD
under Tools and Utilities -> 3™ party products.

In case you get an error like: "invalid page fault in module MSVCRT.DLL" or "<any
program> causes an exceptional fault in the module MSVCRT.DLL" or similar, you see
Microsoft error reports, which are caused by several run time libraries like for C, C++
and WCF. As ETAS software bases on Microsoft library functions this might occur as soon
as you've installed e.g. the LABCAR-CCI standalone package. These libraries need a
minimum version number or even the latest updates of the concerned dlls.

To prevent these errors you have to manual copy some Microsoft DLLs into your installation
directory of the LABCAR-CCI standalone component or into the Windows\system32 folder.

You

find these libraries at the installation CD under Tools and Utilities -> 3rd party products

at the chapter ‘Runtime Libraries of Microsoft '.

Release Notes

28



ETAS LABCAR-AUTOMATION 4.2.3

5.3 Additional Tool Adapters

If you perform a

= repair installation or
= the installation a service pack or
= an installation into the same folder like a former installation,

all additional tool adapters (e.g. Excel) have to be re-installed after the LABCAR-
AUTOMATION installation.

Another practicable method is to set inside the  [Sbsn ek sebomecsi_ = 3 > & L
Visual Studio Project for the reference to the |28 oo (Gt
ATCL the option ‘Specific Version’ to ‘False’. (e jgé._mcé_m - mmﬂ;
This enables VS as soon as the project is built i

to adapt the ATCL version to the actual one,

registered in the global assembly cache.

.3 System Specific Version
- Indicates whether this reference is to a specific
<] Ll =] version of an assembly.

ng Solution Explorer E'm'rsam Explorer |

5.4 General Hints

Since LABCAR-AUTOMATION V3.2.x a LABCAR-AUTOMATION engine log file will be created
(instead of an SAR log file).

You can find the actual logfile(s) directly via the Test Handler Menu at
= Tools -> View SAR Log
= Tools -> Add In... -> Test Handler Log
= Tools -> Add In... -> LABCAR-AUTOMATION Engine Log

Selecting one of 72 Test Handler .
the log files opens | Fie Edt Execution [[ Tools | Felp 1
the latest file 3 5 e f[ Aadim TestHandler Log ich forg
which is been l View SAR Log CirlsL LABCAR-AUTOMATION Engine Log 4
filled by the last M Tk ConErTeney Test Case Status | Start
Test Handler run. (38 Test Bench Qverview

()| Opfions...

N L ST S

Additionally you can find all logfiles in your folder structure at following location:
C:\Users\Public\Documents\ETAS\LABCAR-AUTOMATION 4.2\logging

Any file with the extension .log.# (#=1...n) covers the history of the appropriate log file to
avoid too big log files. Typically the actual log file is sufficient for problem analysis.

5.5 Windows 64 bit restrictions for test case execution

All test cases which are compiled at a 64 bit operating system have to use the compile
option *Compile for x86'.
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5.6 ATCL example test cases

The ATCL Example test cases project contain different tests. There are test bench
configuration files available for this project for different Experiment Environment versions.

The diagnostic test contained in the project has a separate test bench configuration file
(ODXAccess).

For the realtime scripting example there is only an example configuration available to be
used with Experiment Environment in version 3.3.

Additionally there is an example available for the excel tool adapter. This example runs in
fail.
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6 Error List

In this chapter you find information and hints when LABCAR-AUTOMATION throws
exceptions. This list is not exhaustive. It is an assortment of exceptions caused by test
cases’ design or test bench configuration issues.

| Exception | Possiblecauses | Remedy |

AtclConnect
Exception

Atclfactory
Exception

IllegalVerdict
Exception

Parameter
Manager
Exception

ToolAdapter
PortStatus
Exception

Release Notes

Thrown if there was a problem
connecting the test case and the
SARHost (execution host), e.g the
SUT-Mapping file mentioned in the
test bench configuration file is
missing. Check the 'ErrorCode’ for
more information.

Indicates a problem in the
AtclFactory, e.g. the library
Etas.EAS.Atcl.Interfaces in version
1.0.0.2 is referenced, but the Sar-
Host still requires version 1.0.0.1

The IllegalVerdictException indicates
an illegal state transition within the
Verdict class. The state transition of
the Verdict is limited to the verdict
transitions of TTCN-3. Cannot be
provoked from within a test case

This exception is thrown if there
was any error in the
IParameterManager, e.g. when test
case tries to load a parameter that
has not been registered.

Used to indicate an abnormal tool
adaptor status to the ATCL API
user/program. It contains the
TypePortStatusRecord to enable the
user to react on the invalid state of
the tool adaptor. It may occur on
every call to a tool adaptor port. It
is thrown e.g. when a test case tries
to configure a port, that is not in
the state ,ToolConfigured'.

Read exception message
and log-file and fix the
problem mentioned there,
e.g. give the right SUT-
Mapping file as named in
used the .tbc file or adapt
the .tbc file

An error within the Factory
class cannot easily be
provoked from within a test
case. If ATCL in wrong
version is referenced in test
case compared to version
expected by the factory.
Reference the right ATCL
version in your solution
before re-build.

Trial to set a verdict from
error or failed to pass is
invalid and therefore
ignored (that means no
exception), if done in the
test case.

Only if for some reason
(e.g. manipulated verdict
class) a transition within
the verdict class itself goes
wrong, an exception is
thrown.

Register the parameter in
the test case before
loading.

Set the tool into the right
state before starting the
test or include a tool
configuration into your test
case. Information can be
found inside ATCL
referential and the
examples, came with the
installation of LABCAR-
AUTOMATION.

31



ETAS LABCAR-AUTOMATION 4.2.3

| Exception | Possiblecauses | Remedy |

TypeMissMatch
Exception

ETAS.LCA.SAR.
Core.Interfaces.Ex
ceptions.
PortMissing
Exception

Release Notes

Indicates a problem on the type
conversion inside the TypeSutBase
classes. The conversion problem
can either occur during the
transformation to the SAR internal
types or on the way back from the
SAR internal data type to the
TypeSutBase types.

Arises if you try to create a port
which instance name is not declared
in the test bench configuration file.

This is an internal error and
can therefore not be
provoked from within a test
case. Call LABCAR hotline
to get support on this.

Correct the name inside
test case or add the port
into the test bench
configuration file or correct
its name therein.
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7 ETAS Contact Addresses
ETAS HQ
ETAS GmbH
BorsigstraBe 14 Phone:  +49 711 34230
70469 Stuttgart Fax: +49 711 3423 2106
Germany WWW: www.etas.com

ETAS Subsidiaries and Technical Support

For details of your local sales office as well as your local technical support team and product
hotlines, take a look at the ETAS website:

ETAS subsidiaries WWW: www.etas.com/en/contact.php
ETAS technical support WWW:  www.etas.com/en/hotlines.php
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